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READ THIS FIRST!
Installing and Evaluating Your Software

Due to the size of the programs,Th e Crime Zone and Th e Crash Zone are shipped on separate CDs. Th ese pro-
grams are essentially the same. Th ey both contain all the features you need to draw both crash scenes AND crime 
scenes. Only the names are diff erent to be more suited to certain users. For example, investigators who only draw 
crash scenes told us they did not want to use a program called “Th e Crime Zone,” so we have both. You only 
need to install one of the programs, so just install the program with the name that most fi ts the job you do. If 
you think you have the wrong program, go to www.cadzone.com and download the program with the name you 
prefer to use!

Evaluating the Program

When you fi rst install the program, it will be installed as an evaluation version of the soft ware.  You may install 
the evaluation version on as many computers as you wish so multiple people can give it a try. You can open the 
evaluation version 10 times and use every feature of the program, including saving and printing your diagrams. 
When the 10 trial uses are complete, you will no longer be able to save your work until you purchase the soft ware 
and license it. Th ere are three ways you can license your soft ware which are described later in these instructions.

To install the Program: 

• Insert the program CD into the CD ROM drive and wait for it to auto-run.
• Select which program you wish to install, either Th e Crash Zone or Th e Crime Zone.
• From the next screen, choose to Install the program. 
• Click the “Go” button. Th is causes the fi les to be copied from the CD ROM onto your computer’s hard disk 

and the initial program options to be set up.
• Follow the instructions to choose a location (drive letter) and other program options.

If the CD does not run automatically:

• Insert the program CD into the CD ROM drive.
• Select the Windows Start Menu and select the Run command.
• Type D:SETUP   (If the drive letter of your CD ROM drive is something other than D: use that letter here.) 
• Press the Enter key or click on OK.
• When it loads, follow the instructions to select the desired program and install it, as described above.

To use the Program:

• Open the program by double-clicking the desktop icon or by selecting it from Programs on the Start Menu.
• Once installed, you can open the full, working version of the program 10 times. To continue using the unre-

stricted program you must license your soft ware by obtaining an Access Key from Th e CAD Zone.
• Aft er you open the program 10 times, it reverts to an Evaluation Version and the Save File feature is dis-

abled. You can still evaluate the program but you can no longer save your fi les.

Introduction  - What’s the Difference?
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Copyright Laws Apply!

All CAD Zone soft ware is protected by international copyright laws. You probably know you can’t legally make 
a copy of someone’s book (if it is copyright) and give it to everyone in your department or company. Th e same 
protection applies to soft ware. When you purchase a copy of Th e Crime Zone or Th e Crash Zone, you are actu-
ally purchasing a license to use the program on ONE COMPUTER. 

Each purchased copy of the soft ware may be installed only on a single computer.

Th is means you can obtain one Access Key, which allows you to license the soft ware on one computer for each 
copy of the soft ware you purchase.  Th e CAD Zone’s License Agreement is printed on the envelope where you 
will fi nd your program CD. 

How To License Your CAD Zone Software

When you fi rst install one of the CAD Zone’s diagram programs (like Th e Crash Zone, Th e Crime Zone, Quick 
Scene, or Th e Fire Zone), it will be installed in Evaluation Mode. Th is means you can open the program 10 times 
and have access to all of the program features. Aft er those 10 times you can still open the program and try it out, 
but you will not be able to save your diagrams until you complete the licensing of your new soft ware. To license 
your program for unlimited use, you must obtain an Access Key from Th e CAD Zone and enter it into the program. 

Th e Access Key is unique to each computer and is not included in your soft ware package. 

To obtain your Access Key, follow these steps:

1) Purchase the program. Before you can license your soft ware, Th e CAD Zone must have received a Pur-
chase Order from your government agency or have successfully charged your credit card. If you are not 
with a government agency, you must provide Th e CAD Zone with a valid credit card for your purchase.

2) Install the program on the computer where you wish to use it permanently. As 
mentioned previously, you can install the program and use it in Evaluation 
Mode for ten times prior to purchasing.

3) Most CAD Zone programs, when they are fi rst installed, display a message box 
when you open the program that prompts you to license. If the Registration 
dialog box does not appear automatically, select the Help pull-down menu, 
and then select License.

4) Once the Registration Dialog Box is displayed, you will see the Computer ID for your computer (this may 
be called Customer ID in some programs). You must provide this Computer ID to Th e CAD Zone so 
we can generate your unique Access Key. Th is Access Key will ONLY work on your computer. Once you 
enter your Access Key, your program will be fully licensed and you will have unlimited access to all the 
program’s features.

Where To Look For Help
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Once you have your Computer ID (from the Registration dialog box, above), there are three ways for you to 
obtain a program Access Key and complete the registration, or licensing of your soft ware:

1) Online, available 24 hours a day;
2) By email;
3) By phone during CAD Zone business hours.

To License Your Software Online: 

1) When you purchase soft ware from the CAD Zone, you will receive an email notice with information on 
how to log onto the CAD Zone web site and obtain your access key.

2) As instructed in the email, go to http://www.cadzone.com/license and log in to the customer account that 
has been set up for you. Th e email will contain the user name and temporary password. 

2) Once you log in, you will be sent to the “Get Keys” web page. From there, choose the product you wish to 
license and enter the particular computer’s ID. See above for details on how to get the ID.

3) Click “Generate Access Key” to obtain the Access Key for your computer.
4) Write down the Access Key carefully, or use your mouse to copy the Access Key to the Windows Clip-

board. (Drag your mouse over the key to select it, right-mouse click on it, and select “Copy” from the 
menu that appears.) 

5) Immediately open the CAD Zone program you wish to license, bring up the Registration dialog box (as 
described above) and type or Paste in the Access Key. If you copied the Key to the Windows Clipboard, 
right-mouse click in the text-entry box beside the words “Access Key” and select Paste to paste in the Key. 
If the clipboard has been cleared, this will not work so you must type in the entire Access Key. 

You should see a message saying the program was successfully licensed.

Th e Registration (Licensing) 
Dialog Box is normally dis-
played whenever you open a 
program that is still in Evalu-

ation Mode. It shows the Com-
puter ID for this computer.

Introduction  - What’s the Difference?
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To License Your Software Via Email:

 1) Open the program and bring up the Registration Dialog Box, as described above.
2) Click the button “Get Access Key Via Email.”
3) Enter your customer information in the form that is displayed.
4) Click “Submit Email request for Access Key.”

Th is causes an email message to be opened in your email program with all your information already entered. 
Add any other information and send the message. Your Access Key will be emailed back to you so you can enter 
it into the Registration Dialog Box. 

You should see a message that says the program was successfully licensed.

To License by Phone:

 1) Open the program and bring up the Registration Dialog Box, as described above.
2) Call Th e CAD Zone at 800-641-9077 and give us your Computer ID. 
3) We’ll generate your Access Key and read it back to you over the phone so you can enter it into the Regis-

tration Dialog Box. You should see a message that says the program was successfully licensed.

Phone registration is accepted Monday through Friday, 7:30 am to 5:00 pm Pacifi c Time.

CAD Zone Soft ware is protected by United States Copyright laws, just like books and other publications. Th e 
CAD Zone soft ware license agreement specifi es that each purchased copy of a program may be installed on one 
computer! Just as you can not legally make copies of someone else’s book and give them away, you can not install 
our soft ware on multiple computers without a proper license! In some instances, Th e CAD Zone may allow a 
program to be installed on one desktop and one laptop computer that is being used by the same person. Call us 
at 800-641-9077 to see if this might apply to you

Where To Look For Help
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Welcome to The Zone!

Th is quick start guide introduces you to the Crime Zone and Crash Zone drawing programs. It explains the basic 
fundamentals and concepts that will help you get started quickly and accurately. It also instructs you on where to 
fi nd additional help with the program, including tutorials and movies.

Th roughout this guide you will see reference to “the diagram program.” Th is is because the information in this 
guide applies to multiple drawing programs published by Th e CAD Zone, Inc. If you are using one of these pro-
grams, then this guide is for you:

Th e Crime Zone          Th e Crash Zone

Stay Current!

Please note that the Crime Zone and Crash Zone programs are constantly being updated and new features add-
ed. If your version appears diff erent than the one described in this quick start guide, please refer to the electronic 
help for additional instruction on how to use the new features.

It’s easy to keep your soft ware up-to-date with the latest changes. It’s a good idea to check for free updates  every 
few months to make sure you have the latest new features and improvements.  
 Visit Th e CAD Zone’s web site:   www.cadzone.com 
 Click the  "Update" button located at the top right of the home page. 

Follow the instructions on the web site to download the latest update to your soft ware.  When the File Down-
load dialog box appears, be sure to select SAVE and not Run (it’s much too slow to try to run the update over the 
internet). 

Introduction to the Diagram Programs

Th e Crime Zone and Crash Zone were created to fi ll the needs of police offi  cers, private investigators, attorneys, 
and any other professionals who need to create crime and accident scene diagrams faster and easier than ever 
before. Th ese programs contain many special tools that allow the user to easily create accurate diagrams perfectly 
to scale, and will save time at the incident scene and in the courtroom. Even if you are new to computers, these 
programs make it easy for you to create professional looking diagrams with a minimum of eff ort.

What’s the Difference?

Th e Crime Zone  and Th e Crash Zone are essentially the same program. Only the program name is diff erent. 
When you install the program, you can choose which name you want to use. Both programs can be used to cre-
ate crash or crime scene diagrams equally well; there is no need to install both programs from the installation 
CD. Both programs contain all the pre-drawn symbols used to draw crime and crash scenes. You switch between 
the diff erent symbols by selecting them from the “Symbol Groups” located on the Symbol Manager.

All topics in this documentation apply to both programs. For this reason we will sometimes refer to the pro-
grams generically as “the diagram program.” 

Compatibility 

With Th e CAD Zone’s Diagram programs you can import drawings from most other CAD programs including 
AutoCAD®, AutoSketch®, Generic CADD®, and previous versions of the diagram program. Also, the diagram 
program will allow you to save your diagrams to .PDF, .BMP, .WMF, and .JPEG formats for easy placement into 
text documents!
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System Requirements

To install and run the program, we require a PC with Windows 2000, XP, or Windows Vista, 512 MB of RAM 
and 500 MB of free hard disk space. Th e program is designed to be used at a minimum resolution of 1024 x 768.

Where To Get Help

Most users teach themselves how to use the diagram program by working through the available tutorials and 
training movies. Th e Diagram Program provides you with several resources to assist you in successfully learning 
to use the program, including:

The Learning Center 
Th e Learning Center  is the fi rst place to go for help with the program. Th ere are a variety of training materials 
here, including tutorials for those just getting started and Tips and Tricks for using the most complex features. 
Open the Learning Center by selecting it from the Help pull-down menu. Th e Learning Center provides you 
with shortcuts to “How Do I?” topics,  Tutorial Movies,  Electronic Help,  and helpful CAD Zone web links.

Electronic Help
Th e electronic help   (found on the Help pull-down menu) contains step-by-step instructions for every command 
used in the program, as well as the instructional tutorials. Help topics for the toolbox wizards can also be ac-
cessed by clicking the question mark icon  (?) located at the top-right of each command dialog box.

The Training Movies
A separate Training Movies CD-Rom is supplied to you along with the Installation CD. Th e Movies CD contains 
step-by-step instructional movies for most of the commands used in the diagram program and is a valuable 
resource to help you get started fast. If you did not receive a Movies CD, the training movies can also be viewed 
from the training section of Th e CAD Zone’s web site.

Th e command categories on the bottom of the left -hand 
toolbox each have a movie camera icon on the right 
side. Clicking that icon brings up a menu you can also 
use to select training movies for viewing.

CAD Zone Training Web Site
Th e CAD Zone’s training web site contains tutorials, 
command reference manuals, training movies, and 
other User Documentation. It even contains a number 
of training manuals that have been submitted by some Crash Zone and Crime Zone trainers.

To enter Th e CAD Zone’s training web site, select the Training button from our home page: www.cadzone.com  or 
enter this address into your browser:   http://training.cadzone.com/
If you prefer to attend a formal training session, many classes are listed on Th e CAD Zone’s Training Site. Select 
“Training Events.” From this web page you can select to view classes that have been scheduled by our trainers 
throughout North America. You can also locate a trainer near you if you want to fi nd out more about the type of 
training they off er.
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Free Technical Support
You are welcome to contact Th e CAD Zone directly for your technical support  needs. We continue to provide 
this service free of charge. You can receive Email support by submitting your questions to: info@cadzone.com. 
Telephone support is available at: (503) 641-0334, Monday-Friday, 7:30 a.m. - 4:30 p.m. Pacifi c Time.

About This Manual

Th is booklet is NOT a comprehensive manual on how to use Th e Crash Zone and Crime Zone. It does not con-
tain any tutorials or explain how to use the various features of the programs. All of that is covered in the elec-
tronic help and movies, as discussed in the section “Where to Get Help,” above.

Th e purpose of this manual is to show you what tools are available in the program and give some examples of 
when you can use a particular feature to get the job done. Some features will be used by everyone, regardless of 
the type of diagrams you are creating.  Th ese are covered in the sections “Program Concepts” and “Basic Tools.” 
You may be more likely to use certain features when creating crash scene diagrams, so they are described in the 
section “Tools for Drawing Crash Scenes.” Similarly, if you focus on investigating crime scenes, take a look at the 
section titled “Tools for Drawing Crime Scenes.”

Start Here! 

To use any type of soft ware accurately and effi  ciently you must understand some basic concepts and when to 
apply certain tools. Just like word processor or email applications, diagramming soft ware has its own unique set 
of concepts that you can apply, regardless of which program you are using.  It’s important that you understand 
where to look for information on the program screen, how to select commands, how to read the mouse pointer, 
how to snap to points and objects, how to change views and layers, and so on. 

Th e CAD Zone Training Web Site
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Vector Drawing Vs. Bitmap

Th ere are two basic types of drawing soft ware programs, referred to as “vector based” and “bitmap.”  With bitmap 
drawing  programs, like Microsoft  Paint, your drawing is simply a collection of dots, or pixels, of  diff erent colors. 
You change the color of pixels in a row to create what looks like a line, but to the program it’s still just a row of 
colored dots.

Th e Crash Zone and Crime Zone are vector-based drawing programs, meaning you construct your diagram by 
creating objects such as line, circles, rectangles, text, colored fi lls, and so on. Th is method is best for law enforce-
ment diagrams where accuracy is extremely important. You draw objects in the program that match the exact 
measurements you collected at the scene, just as you would draw them on paper using a ruler. 

Always Draw at 1 to 1 Scale!
 You never have to calculate a drawing scale  when you draw. You draw everything to the actual measurements that 
you took at the scene, in other words, use a 1 to 1 scale. We’re used to having to scale our measurements to fi t 
on a piece of paper, but the computer doesn’t have that restriction! Th ink of it like drawing on a sheet of paper 
that is infi nitely large.  If you want to draw a building that is 200’ x 150’, you tell the program to create a rectangle 
with those measurements. 
Once an object is drawn, its size never changes (unless you choose to scale it) so accuracy is always maintained. 
You can zoom in on an area of your drawing to make an object look larger on the computer screen, but that sim-
ply changes the display, not the actual size of the objects. It’s like using a camera with a zoom lens.

You only have to set a drawing scale when it is time to print your diagram on paper. Th e program can calculate 
a printing scale for you, based on the paper size you select, or you can specify an exact scale.  Drawings can be 
printed on large format plotters, or you can “tile” a drawing across a number of pieces of paper and tape them 
together to create a larger print.

2D Vs. 3D Drawing and Viewing

Th e Crash Zone and Crime Zone can be used to create 2D diagrams or complex 3D models of a scene. It’s very 
diffi  cult for most people to draw in three dimensions while looking at a two-dimensional computer screen. For 
this reason, all your drawing will be done in 2D. If you want to create a 3D model of a scene, you simply assign 
a height to objects and an elevation (the distance above the ground plane) and let the program create the 3D 
model for you! 

You launch the program’s 3D Viewer to display your scene in 3D. Th en you can view it from any position and 
even walk through the scene. All of the program’s predrawn symbols will display in 3D, along with any bodies 
you create with the Body Poser tool. It is also possible to easily create accurate, 3D surfaces from data you have 
collected with a laser measuring device, such as to show a road, hill, ditch, or other surface.

Th e accuracy of your 3D model completely depends on the accuracy with which you create your 2D diagram.  
Th e 2D diagram has to come fi rst. For this reason, most of this manual will be dedicated to introducing the tools 
you need to draw in 2D. Th ere are a variety of movies and electronic help topics on using the program’s 3D fea-
tures, to which you can refer when you’re ready for 3D.

Draw at 1 to 1 Scale!
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Let’s Get Started!

When you fi rst launch the program, a 
special dialog box appears to help you 
get started on your diagram. Th e fi rst 
step is to enter the diagram name you 
wish to use, select the units and select 
the precision (units to the right of 
the decimal place) to be displayed for 
dimensions. 
Next, you can select a starting tool, if 
you wish, to start the diagram by draw-
ing an intersection,  a building fl oor 
plan, opening an existing intersection 
template, or entering hand measure-
ment data with the Coordinate Data 
Table.  You can also pick an approxi-
mate site size, which zooms the display 
in or out to show that amount of space. 
Th ere is a button on the left  side which 
opens the Learning Center . Once you 
make your selections, click OK to continue to the program screen.

If you prefer to go right to the program screen, just check “Don’t show this dialog again”.

The Program Screen 

Aft er making your selections from the “Let’s get started!” dialog box, you will see the main program screen . Most 
of the screen is covered by a blank, white window where you will create your diagram. Let’s take a look at what 
else makes up the program screen.

Create a diagram like this in 2D and just one click lets you view the 3D model! Symbols are 
viewed in 3D automatically. You can also assign heights and elevations to other objects (like 

buildings) and create accurate 3D surfaces from your measurements.
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Pull-down Menus – All of the program commands can be selected from these menus , organized into com-
mand categories. Most commands can also be selected from the left -hand toolbox.

Speed Bar – Th e row of icons just below the pull-down menus include basic Windows functions such as open 
fi le (diagram), create new, save, copy/paste, print, undo,  and redo. Th ere is also an important properties 
display here, along with Snap and viewing (Zoom) commands.  Th e icons at the far right of the Speed Bar 
are used for creating 3D models. Th e commands on the Speed Bar remain the same during 2D drawing.

Left -hand Toolbox – Using the left -hand toolbox is a fast way to select the most commonly used features.  
Th e commands found on the toolbox are arranged in groups or categories of similar features, just as they 
are arranged on the pull-down menus.

Drawing Area – Th e large, blank window is the area where you create and view your diagrams.
Message Bar – Once you start a command, refer to the yellow Message Bar at the bottom of the screen for 

step-by-step instructions on how to complete it. Th e Message Bar  also displays properties of an object 
that is selected (like dimensions, area, and layer) and a dynamic coordinate display that gives the cursor 
position using two diff erent coordinate systems (Angle/Distance and X/Y).  

Scroll Bars – located at the right and bottom of the Drawing Window, these bars enable you to scroll the view 
of the diagram up and down or side-to-side within the drawing window.

Whenever you’re not sure what to do next, look at the Message Bar at the bottom of the 
program screen! Th e program will be much easier to learn and use if you get into the habit 
of always referring to the Message Bar!

The Program Screen
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Using the Keyboard
Th ere are three ways to start nearly every command (feature) in the program. By looking at the program screen, 
it’s pretty obvious that commands can be selected from the pull-down menus and from the left -hand toolbox.  A 
third way to start many commands is by entering the appropriate two-letter shortcut on your keyboard , such as 
ZW for Zoom Window or C2 for 2-point Circle. Th e two-letter shortcuts are listed in the electronic help, and 
they are shown on the pull-down menus, to the right of each command name.

Th ere are a couple other keys on your keyboard that you will fi nd to be very useful as you 
draw - the Esc key and the Space Bar.

Esc key (usually in the upper left  of your keyboard) – Th e “Escape” key is used to take a step backwards, or 
back out of a command. For example, if you are placing points to draw a curve, pressing Esc will undo the 
last point (without canceling the entire command) so you can place it diff erently.

Space Bar – Pressing the Space Bar on your keyboard will repeat the previous command. Th is can be a great 
shortcut when you need to draw the same object or place the same symbol in multiple places.

Placing Points with the Keyboard
You will also use your keyboard for entering measurements as you draw, which ensures the accuracy of your dia-
grams.  For example, you can draw a line by simply selecting the Line command and using your mouse to click 
the two endpoints, but that does not ensure that the line has the exact length you want. Another way to draw a 
line more accurately is to use the “Direct-Distance” method:

Select the Line command, click (or snap) to place the fi rst endpoint.1. 
Move the mouse in the direction you want the line to go.2. 
Type the distance to move to place the next endpoint. Th is is the length of the line.3. 
Th e line is drawn to have the exact length that you entered on the keyboard. 4. 

You can use this method of entering measurements on the keyboard any time you need to 
place a point at an exact distance away, such as the second endpoint of a line, a point on a 
circle, or a corner of a rectangle. 

Using the Mouse
As you create your diagrams, you will use your mouse extensively.  Th e mouse is the easiest way to select com-
mands from the pull-down menus, the Speedbar and the Left -hand Toolbox. Th e mouse is also used to place 
points and symbols in the diagrams and to select objects for editing.

Almost all operations you do will be with the left -mouse button. As you use your mouse for diff erent functions , 
the mouse pointer (cursor) will change to remind you of the current program mode. Th e Mouse Pointer starts as 
an Arrow Pointer but will change depending on which feature you are using.  

Th e Arrow Pointer is the default shape for the mouse pointer. When your mouse pointer looks like 
an arrow, you are in “selection mode” which means you can click on any object to select it, or use 
any of the various mouse selection methods (see the later section on Editing and Selection).

When you start a command, such as to draw a line, the mouse pointer changes to a crosshair. Th is 
means the program expects you to select some point in the diagram.  Th ere are essentially an 
infi nite number of points in the drawing window, so if you want to select an exact point on an 
object, like an endpoint or midpoint, you must use one of the Snap commands (discussed below).

Using the Keyborard and Mouse
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If the Mouse Pointer looks like a cross hair enclosed in a circle, Auto Snap mode is turned on.   
Auto Snap can be selected from the Speedbar. When you have Auto Snap turned on, the cursor 
will snap to a point, line or object within the Target circle so you can draw with precision. To 
turn Auto Snap on/off , select the red magnet icon on the speed bar.  

When an object (or objects) is selected, and you move the mouse pointer inside the selection 
handles, the mouse pointer turns into a 4-sided arrow. In this mode, holding down the left -
mouse button allows you to drag, or move the selected objects to a new location in the dia-
gram.

When you select an object (or objects), a red square appears at that object’s rotation handle. If 
you place the mouse pointer on the red square, it turns into a curved arrow. When the cursor is 
in this mode you can hold down the mouse button and rotate the object to a new angle.

When you select an object (or objects), it is highlighted and enclosed in blue squares. Th ese 
squares are handles you can use to stretch the object. If you place the mouse pointer on one of 
these handles, it turns into a two-headed arrow. With the cursor in this mode, hold down the 
mouse button and drag that handle to a new position, stretching the object.

If you position your mouse pointer on some object in the diagram and click  your right-
mouse button, a menu of shortcut commands is displayed.  Th is menu provides a fast 
method for selecting commonly used functions like zooms and editing commands.

Snaps and Accuracy

In order to create precise, accurate diagrams, you must know how to select and place points and objects ex-
actly.  Th e way to do this is by using “Snap commands.” Using Snaps   ensures that your fi nal drawing is accu-
rate with lines and symbols attached neatly together. 

For example, suppose you have measured the fi nal location of a vehicle in a 
crash and you want to place the tires of a vehicle symbol at that exact point. 
If you simply click with your mouse to place the symbol in the diagram, 
you may get close to the desired point, but if you zoom in on it, eventually 
you will see that the symbol was not placed exactly. To select a point that is 
exactly on an existing object, you must snap to that location.

Th ere are diff erent Snap commands that you will apply to diff erent situations.   
Some Snaps allow you to snap exactly to the closest endpoint of a line, to the 
closest point on a line (not necessarily the endpoint), to the center of a circle, 
or to the midpoint of a line.  Th ere are also Snap commands that make it easy 
to draw a line that is exactly perpendicular to another line or to draw a line 
that is tangent to a circle or curve. Pull down the Snaps menu at the top of 
the screen to see all the Snap commands that will help you draw with greater 
accuracy.

Use Snap Commands for Accuracy
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Auto Snaps (AU)
Th e automatic way to ensure you always snap to the closest endpoint or object 
is to turn on Auto Snap  by clicking the icon on the Speedbar that looks like a 
Horseshoe Magnet.  With Auto Snap turned “On” the mouse pointer shows as 
a small target whenever you are in the mode of placing a point.  Just move that 
pointer so the desired point (such as the endpoint of a line) is inside the target and click the mouse button to au-
tomatically snap to that point.  If there is no endpoint or object within the Auto Snaps target, the point is placed 
in the diagram without snapping.

As the name implies, Auto Snap puts you in the mode of automatically snapping to a nearby point, without hav-
ing to select one of the other Snap commands.  Auto Snap is a “toggle,” meaning it is either on or off . When Auto 
Snap is turned on, the button on the Speedbar looks pressed in and is green. Sometimes you may want to click 
close to another point without snapping exactly to it. If you fi nd the mouse pointer automatically jumping over 
to a nearby point when it is not what you intended, click the Auto Snap icon again to turn it off . 

 Constraining Mouse Movement

Two other commands on the Speedbar will also help you draw more accurately – Angle Draw  90° and Angle 
Draw 45°. Similar to Auto Snap, these commands are toggles, they are either turned on or off .  If they are turned 
on, they will look “pressed in” and have a green background. If they are turned off  they will have a tan or gray 
background and look like the other Icons. 

Angle Draw 
Th e Angle Draw  command icons look like a small carpenter’s square. Th ese commands constrain the mouse to 
only move at the chosen angles, just like using a carpenter’s square to constrain your pencil to only draw at ex-
actly 90°.  If Angle Draw  90° is turned on and you start drawing a line, once you click (or snap) to place the fi rst 
endpoint you can only move the mouse pointer exactly horizontally or vertically.

You can actually constrain the mouse movement to any 
angle, not just 90° and 45°.  To do that, select the Snaps 
pull-down menu and place your mouse on Angle Draw  
Commands to display a list of options. Click on “Set angle” 
and enter the desired angle on the options bar that ap-
pears.  For example, if you were drawing a building that 
had several 30° corners, you could constrain the mouse to 
only move at 30° and 120° from horizontal. Th e angle you 
enter for Angle Draw mode is always measured counter-
clockwise from a line exactly horizontal to the right.

Turn Angle Draw  90° ON when you want to place text so it 
is exactly horizontal. Another shortcut method of con-
straining the mouse to only move horizontally is to hold 
down the Ctrl key on your keyboard before you place the 
second point!

Auto Snap and Angle Draw
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Changing Views          

As your diagrams become more complex, you can quickly fi ll the screen. When you show the entire diagram on 
the screen (using the Zoom All command) it may be diffi  cult to see the smaller details.  Th ere are several diff er-
ent View commands    designed to change how your diagram is displayed on the screen. You can zoom in  to draw 
small details and zoom out to make more visible space for placing a large item, like a building or intersection.

All of the View commands can be selected from the View pull-down 
menu. Th e most commonly used View commands can also be selected 
from the Speedbar, the toolbar that runs across the top of the drawing 
window. Th ese include:

Redraw - Use this command to refresh the screen. If you do some edit-
ing and deleting and it looks as if some objects have been partially 
erased, don’t panic, just do a Redraw!

Zoom Window - Th is command let’s you use your mouse to draw a 
window around some details in your drawing. Th ose details are 
expanded to cover the entire screen. Use Zoom Out or Zoom All 
to show more of the drawing again.

Zoom All (Extents) - When you have zoomed in to show details of your diagram, select Zoom All to display 
the entire diagram on the screen.

Zoom Out - Reduces magnifi cation of the view by half, making everything look smaller on the screen.
Zoom In - Increases the magnifi cation of the view by two, making everything look larger on the screen.
Zoom to Previous -Returns the screen to the previous view. Th is can be helpful if you zoom in on some in-

tricate details, do a Zoom All, then realize you were not fi nished on the details and need to return to that 
exact view.

Remember that the View commands never change the actual size of objects in the dia-
gram! If you draw a building to be 100’ long, it remains 100’ long, regardless of how large 
or small it appears on the screen. View commands are just like using a magnifying glass or 
the zoom lens on a camera.
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Tools For Everyone

Some of the features in the diagram program have been developed with a certain user in mind, like 3D Wall 
Evidence for crime scene investigators and the Skid Analysis tool for crash reconstructionists. Most of the fea-
tures in the program will be applied by everyone, regardless of the type of diagrams being created. Th is section 
introduces the basic tools that every user should get to know.

Drawing Tools

 Everything in your diagram will be constructed of basic objects, like lines, arcs, 
curves, circles, rectangles, text, and so on.  Lucky for you, you do not have to 
actually draw every individual object in your diagrams because many tools 
have been provided that do a great deal of the drawing for you! Th ese special 
tools allow you to draw complex 3D vehicles (as symbols), create multi-lane 
intersections with medians and crosswalks, and draw fully posed bodies – all 
with just a few mouse clicks!

Even with all this being done for you, it is still important that you learn to use the drawing commands, in 
order to create fi nished, courtroom quality diagrams. You may want to add lines or arcs for skid marks, place 
arrows (leaders) to show where evidence was found, or draw rectangles for nearby buildings or parking lots.  
Likewise, if you import data from some other source (like a laser measurement device or photogrammetry) 
you will still have to draw some basic objects to complete your diagrams. 

Th e left -hand toolbox includes a variety of commands for drawing basic objects.  Th e most commonly used 
Draw commands are found on the Quick Pick toolbox . Select the Draw/Snaps/Hatch category to fi nd icons 
for even more drawing commands.  You can also select any of the Draw commands from the Draw pull-down 
menu.  Th ere are multiple commands for drawing some objects, like arcs, because they can be drawn in diff er-
ent ways depending on what kind of measurements you have.

Th e Electronic Help and the Learning Center   movies show exactly how to perform each 
of the Drawing commands, so we are not going to explain each of them here. Th e best 
way to learn to draw objects is to just experiment with each command.  Start a new, 

blank diagram and try out each command, fi rst by just clicking the mouse button to place points. Be sure to 
look at the yellow Message Bar at the bottom-left  of the screen for prompts on what to do next.

Once you understand how the commands work, try using the Direct-Distance method 
of specifying where to place the next point (discussed earlier under “Using the Key-
board”). For example, select the Continuous Line command and click to place the fi rst 
endpoint. Turn on Angle Draw 90° (on the Speedbar) so you can draw exactly

horizontally and vertically. Move your cursor to the right and type a measurement. Th e next endpoint will be 
placed at that exact distance. Move your cursor up and type the next measurement to continue the line.

When you want to connect two basic drawing objects together exactly  you must use 
Snap commands (as discussed earlier). Suppose you have an existing line or rectangle in 
the diagram and you want to attach a new line exactly to one endpoint. Make sure

Auto-Snap is turned ON, start the line command, position the mouse pointer so the desired endpoint is inside 
the target on the mouse pointer, and click. Th e new line will snap to the existing endpoint so it is attached 
exactly to it.
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Easy Lines

Easy Lines is a special tool that was developed to make it easier to draw accurately when you have 
measured data by hand (as opposed to taking data with a laser device).  Instead of clicking endpoints 
with your mouse, you 
use a special toolbox 
to enter the angle and 
distance used to place 
the next endpoint of 
the line. Easy Lines 
is a great tool to use 
for creating a draw-
ing from hand mea-
surements. Depending 
on how you collected 
your measurements, 
Easy Lines has modes 
of Normal, Baseline, 
and Triangulation 
measurement entry. 

You can also use  Easy 
Lines to place “Mark-
ers” instead of placing 
endpoints of a line.  
Markers are useful 
for locating the start-
ing endpoint of an 
interior wall, locating 
evidence, wheel centers, and so on. Markers are placed with exactly the same method as Lines, except 
you complete the entry of each angle and distance by selecting the blue, Marker icon from the bottom 
of the toolbox instead of the red, Line icon.

Object Properties

Th ere are a number of properties   associated with each basic object, 
such as color , line type  (style), width  (thickness), and layer. Select 
the properties you want to use before you start a drawing command, 
then all the basic objects you draw from that time forward will have 
those properties. Th is does not apply to symbols or anything drawn 
with Easy Builder or Easy Intersection. You can also change the properties of any object aft er it has been drawn.

To select object properties for future objects you wish to draw, select the Properties icon on the Speedbar, or type 
PP on the keyboard. Th is displays the properties settings bar where you can make your selections.

Th e default object properties when you start a new diagram are always Layer= 0, Color = Black, Line Type = 
Solid, and Width = 0 (the thinnest possible line). Th is image shows how changes have now been made to each 
property. Th e Properties icon on the Speedbar changes to show the currently selected properties.
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To change the properties of an existing object, click on it to select it and then click the Properties icon on the 
Speedbar. You can also 
right-mouse click on a 
selected object and select 
Properties from the 
menu that appears. Th is 
brings up the Properties 
bar (as shown above) 
where you can make 
your selections. Click 
OK to apply the new 
properties to the selected 
object.

Use the pointing hand icon on the Properties bar to select some other object whose 
properties you want to match! Use the Norm icon on the Properties bar to return all 
property selections back to the program defaults.

Line Types
When  drawing lines, curves, arcs, and other basic objects, you can choose from 
over 100 diff erent line types .  Th ere are basic dashed and dotted line types and 
many others that can be used to represent lane lines, fences, footprints, skid 
marks, medians, streams, trees, and more. You can select any of the available 
line types from the properties bar (discussed above), but some of the names are 
obscure. 

An easier way is to select Line Types from the left -hand toolbox. All the line 
types  are shown with an icon and, if you place your mouse on any of the icons, 
a more descriptive name is displayed. Use the scroll arrows to scroll through the 
entire list of available line types.

Simply click on any of the Line Types on the toolbox to use that style for drawing 
future objects. To change the Line Type of an existing object, click on it to select it 
and then select the desired Line type from the toolbox to apply it to that object.

Do not have the Properties Bar at the top of the screen 
displayed at the same time as you are selecting Line Types 
from the toolbox as this overrides your new selection!

Editing Existing Objects

As you draw, you will soon realize you need to make changes – move objects, erase objects, shorten objects, 
change the size of objects, and so on.  Th ere are a large number of  Editing commands just for making changes to 
the objects in your diagram. Th e most commonly used Editing commands are found on the Quick Pick section 
of the Left -Hand Toolbox. Even more Editing commands are located on the Edit section of the Left -Hand-Tool-
box and on the Edit Pull-Down Menu.

Th e Editing commands are all discussed in the Electronic Help and demonstrated in the Learning Center  mov-
ies. Refer to them for help on how to use specifi c commands.
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Just like when drawing, you must use 
Snaps if you want to edit with 
precision. For example, you can use 

your mouse to drag a vehicle symbol to its approximate fi -
nal location, but to place it accurately you would fi rst mark 
the fi nal location of the wheel centers with points (accord-
ing to your measurements), then move the vehicle and 
snap it exactly to those points. If you’re lucky enough to 
have access to a laser measuring device, you will get all the 
important points marked in your diagram when you bring 
in your measurement data. Th en you simply snap symbols 
to the points to complete it!

Selecting Objects to Edit
Before you can perform an editing command, you must select the object or objects in your diagram that you 
want to change. It’s easy to  select a single object, you simply left -mouse click on it. However, you will frequently 
want to modify a number of objects at once, whether to change their size, move all of them to a new location, 
or change their properties.  Being familiar with the various selection methods makes drawing and editing much 
faster because you can quickly select just the objects you want to modify.

You can see all the selection commands by choosing “Select” from the Edit Pull-down menu. However, the most 
commonly used selection methods can be performed with just the mouse (you do not have to choose a com-
mand). 

 

To select a single object – click on it 
with your mouse.
 

To select multiple objects with a 
selection window - Place your mouse 
above and to the left  of the objects, 
hold down the mouse button and drag 
the mouse down and to the right. 
You will see a selection window take 
shape. When all the objects you want 
to select are fully enclosed in the win-
dow let up on the mouse button.

To select objects by crossing through 
them – Place your mouse below 
and to the right of the objects, hold 
down the mouse button and drag the 
mouse up and to the left . You will see 
a selection window take shape on the 
screen. When all the objects you want 
to select are crossing, or fully enclosed, 
in the window let up on the mouse 
button.
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Sometimes you can’t select the exact objects you want with one window so you will want 
add or delete objects from the selection set. Once some objects are selected, use the Shift  
and Ctrl keys on your keyboard to fi ne-tune the selection. 

To add objects to the selection - Hold down the Shift  key and click on an object to add it to those that are al-
ready selected, or use another selection window (while holding Shift ) to add multiple objects.

To delete  objects from the selection - Hold down the Ctrl key and click on an object so it is no longer selected, 
or use another selection window (while holding Ctrl) to de-select multiple objects at the same time.

If you start one of the Edit commands before you have selected objects in the diagram, a 
Selection toolbar appears at the top of the drawing window (just below the Speedbar.) You 
can use these commands to select objects or use the mouse methods described above. 

When you have fi nished editing, click Ok on the Selection toolbar to continue with the editing command.

Using The Mouse To Edit
When an object or objects are selected, they are displayed pink and surrounded by small blue squares, or selec-
tion handles.   Th ere is also a red target symbol and a red square (rotation handle) displayed near the center of the 
selected objects.  Use your mouse to manipulate these special handles as shortcut methods to move, rotate, and 
re-size selected objects: 

To move the selected objects -  place your mouse 
pointer inside the blue selection handles and hold 
down the mouse button to drag them to a new 
location. (If you want to snap objects to a precise 
point, use the Move command under Quick Pick 
or Edit on the left -hand toolbox.)
 
To rotate the selected objects -  place your mouse 
pointer on the red, square rotation handle near 
the center of all the selected objects and drag your 
mouse in a circular motion. (If you want to rotate 
objects an exact angle, use the Rotate command so you can enter the precise angle.)
 
To scale, or resize, the selected objects –  place your mouse pointer on any of the blue, square selection 
handles and hold down the mouse button to drag them to a smaller or larger size. If you want to resize objects 
proportionally, not changing their ratio of width to height, just drag one of the corner selection handles to the 
new size.

If you have a large diagram and you select a small object, you may see it turn pink but not 
be able to see the selection and rotation handles.  Simply use the Zoom Window command 
to zoom in around the object until the handles are displayed.
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Using Editing Commands
Once you have selected the objects you want to modify, you can use any of the 
 editing commands on the Edit pull-down menu and on the left -hand toolbox 
to make the changes. Th ere are commands for moving, rotating, trimming and 
extending, copying, breaking openings, stretching, mirroring, and so on. For 
some edits, there is more than one command so you can choose the one that 
gives you exactly the results you want. For example, if you want to make a copy 
of some objects you can use the standard Copy to the Windows Clipboard, 
Multiple Copy, Linear Copy, Radial Copy, or Array copy (rows and columns). 

Whenever performing an Edit command, be sure to look 
at the yellow Message Bar at the bottom of the screen.  
Th is is where you will get instructions from the program 
telling you what to do next!

Many of the Edit commands require you to choose a reference point, or handle, 
and a new location for that handle. For example, when you start the Move  com-
mand, you are fi rst prompted to “Pick Reference Point.” You can click on any 
point, or snap to grab an exact point. Th ink of this as the handle by which you 
will pick up the object. Next you are prompted to “Pick Off set Point.” Th is point 
is the new location for the handle. If you wish to move the objects to some exact point, be sure you use Snap 
commands to identify the reference points!

All the other Edit 
commands are per-
formed in a similar 
way. You can refer to 
the Electronic Help 
and the Learning 
Center  movies for 
detailed instructions 
on how to use each 
command. 

Pre-drawn Symbols

Th ere are thousands of pre-drawn symbols  included in the program which you can use in your diagrams.  Sym-
bols are included for most items you will want to show in a crash or crime scene investigation diagram.  Select 
Symbols from the left -hand toolbox to display the Symbol Manager.  Th is toolbox makes it easy to fi nd a particu-
lar symbol and place it in your diagram at the exact size, rotation, and color you want.

Th e symbols are divided into basic groups of Crash, Crime, Marine, and “My Symbols” which are symbols you 
create yourself. Th e top of the Symbol Manager toolbox shows the current group (Crash in this image) and has 
a pull-down arrow that you use to select a diff erent symbol group.  Within each basic group, there are buttons 
at the top for diff erent categories of symbols. Most of those categories are even further divided to make it easier 
to locate a particular symbol.  In the example shown here, the    Vehicles A category is divided into Cars, SUV’s, 
Vans, and so on. Once you select a category, preview images for those symbols are shown on the Symbol Man-
ager, arranged alphabetically. Use the scroll bar or arrows on the right side of the Symbol Manager to view all the 
symbols in the category.
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Symbols like vehicles and weapons are drawn to actual 
size. You should always be drawing to actual measure-
ments (1:1 scale), so when you place a gun symbol into 

a building fl oor plan it will look very small.  However, the gun will be the cor-
rect size that an actual gun would be relative to other objects in a room. You 
can use Dynamic Symbol Scale to make a symbol larger or smaller when you 
place it, but be aware that you may be giving the object an unrealistic size.

Placing Symbols
Once you select the symbo l you want, here is how you place it in the diagram:

Move your mouse pointer into the drawing window. You will see a pre-1. 
view of the symbol attached to your mouse pointer.

Click or snap to place the symbol’s initial handle point where you want 1. 
it. Th is point is an anchor, or pivot point, for the symbol.

Move your mouse and notice the symbol rotate around the anchor 2. 
point. When the symbol has the desired rotation, click or snap to fi nish 
placing it.

Click the Back button (arrow pointing left ) in the lower-right of the 3. 
Symbol Manager toolbox to close it.
Most of the pre-drawn symbols have one handle point on the left  side 4. 
and one on the right side. To place these symbols the way they look on 
the Symbol Manager preview, click or snap to place the initial anchor 
point, move your mouse exactly horizontal to the right, and click or 
snap to place the second point.

If you make a mistake when placing the symbol’s initial 
anchor point, press the Esc key on the keyboard. Th is 
will release the symbol so you can place the anchor point again.
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Turn on Angle Draw 90 (on the speedbar) if you want to place a symbol exactly horizontal 
or vertical. Th en, once you place the fi rst anchor point, you will only be able to rotate the 
symbol in exactly 90° increments. If you want to place a symbol at some other angle, make 
sure Angle Draw is turned off .

Symbol Placement Options
Along the bottom of the Symbol Manager toolbox are several op-
tions that let you mirror, change the size, change the color, and 
explode symbols as you place them. Just select the desired symbol 
from the Symbol Manager then select the option you want to use. 
For example, to make symbols larger or smaller as you place them:

Select the desired symbol.1. 
Select the Dynamic Symbol Scale option from the bottom of the Symbol Manager. 5. 
Click or snap to place the anchor point for the symbol.6. 
Move the mouse pointer and notice that you can now make the symbol larger or smaller as well as rotate it 7. 
around the anchor point.

When the symbol has the desired rotation and size, click or snap to fi nish placing it.8. 

Th e other symbol placement options work the same way, allowing you to modify the symbol as you place it. 
Refer to the electronic help for more information on all the options for placing symbols.

Create Your Own Symbols
Th e pre-drawn symbols  will save you countless hours of 
drawing time, but, if you can’t fi nd exactly the symbol you 
need, you can also create and save your own symbols.  First, 
draw what you want for the symbol and select everything, start the Create Symbol Wizard (the star icon) from 
the Draw pull-down menu or from the Symbol Manager on the left -hand toolbox, and follow the instructions to 
create and save your new symbol.  

Any symbols you create are automatically saved into the “My Symbols” group.  Th e current symbol group (Crash, 
Crime, Marine, or My Symbols) is shown at the top of the Symbol Manager Toolbox. To change symbol groups, 
click the pull-down arrow next to the name of the current group and select a new one from the list.

Placing Text and Dimensions

Th ere are a number of commands for placing text  and dimensions in your diagrams. Th ey 
are found on the Quick Pick  section and the Text/Dimensions sections of the left -hand 
toolbox and on the pull-down menu. 

Using The Text Command
Th e Text command is the most commonly used command to place text labels and notes.  It lets you adjust the 
text  height, center it, change the font, make the text bold, italics and underlined, add an arrow, and change sev-
eral other text properties. 
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To place a note or label in your diagram:

Select the Text command. Th is displays a “fl oating 1. 
toolbox” of text placement options that you can drag 
around the screen with your mouse.

Enter the desired text in the box below the words 2. 
“Enter Text” or click on one of the pre-defi ned labels 
from the list shown. You can add and remove labels 
to customize your list of frequently used text.

Move the cursor back into the drawing window to see 3. 
an outline box previewing the size of the text. 

Adjust the size of the text by entering an exact height 4. 
or by repeatedly clicking the big “A” or small “A” but-
tons on the toolbox.

Turn on “Repeat” if you want to place the same text in 5. 
several locations.

Turn on Angle Draw6.    90° to place the text exactly horizontal or vertical.
Click (or snap) once to anchor the text, move the mouse to rotate it to 7. 
the desired angle, and click again to fi nish it.  

You can also turn on the option to “Show Arrow” which 
places a   leader (arrow) with the text. In this case, the 
fi rst point you click (or snap) places the tip of the arrow,

the second point you place becomes the shoulder of the arrow. Once the arrow 
is drawn, move the mouse pointer to the right or left  to determine the position 
of the text and click again to place it.

Placing Dimensions
Th ere are several commands for showing  dimensions and measuring distances in 
your drawings. Dimensions are used to show the length of an object, like a wall or 
road section; they can show the distance between objects or any other measurement .

When you place a dimension, the program displays the distance between the points 
exactly as it was drawn.  Th is is another reason why you want to construct your diagrams at 1 to 1 scale, using exact 
measurements, whenever possible.  Occasionally you may want to overwrite the dimension value that the program 
calculates or add a text note to the dimension value. Th is can be done by typing in the box where the dimension 
value is displayed on the Dimension toolbox.

It’s critical to use Snap commands  when placing dimensions to ensure you measure from 
the exact point you intended. When you place a dimension, you will want to snap exactly 
to the endpoint of a line, the corner of two walls, or wheel centers of a vehicle. Th e easiest 
way to make sure you are snapping to points exactly is to turn on Auto Snap.

Th e Dimension and Measure commands can all be selected from the Text/Dimension section of the left -hand 
toolbox and on the Text/Dimensions pull-down menu . Th ere are commands for dimensioning along a line, an 
angle, and the radius of a circle. To place any type of dimension, be sure to follow the prompts on the yellow 
message bar at the bottom of the screen!
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To dimension a line, such as a wall or road segment:

1. Select the Dimension command from the left -
hand toolbox. 

2. Snap to the fi rst endpoint of the line (Pt 1 in 
the fi gure). 

3. Snap to the second endpoint (Pt 2).  Th is de-
fi nes the length to be dimensioned.

4. Move the cursor away from the object and 
notice an outline of the dimension. 

5. Click the big A or small A buttons on the tool-
box to adjust the text height.

6. Click the “More Settings” button to make 
changes to the font, arrow type, units, and 
other options.

7. Click a fi nal time (Pt 3) to position the dimen-
sion text.

You can continue to place dimensions in this man-
ner by snapping to two new points. Th e program 
stays in dimensioning mode until you close the 
Dimension Toolbox.  

Once a dimension is placed in the diagram, it can easily be changed. First, click on the dimension to select it and 
then click your right mouse button to see a menu of editing commands that can be applied.  Th e Slide Text feature 
allows you to move the dimension value outside of the dimension lines, which can be very helpful in situations 
where the space is limited.

Th e units   and number of decimal 
places displayed in your dimensions 
can be changed by selecting Units 
from the Utilities pull-down menu.

Th ere are several other Text and Dimension commands 
included in the program. Refer to the Electronic Help and 
the training movies for more information on how to use 
each command.

Hatch Patterns and Color Fills

It is easy to fi ll any area of your diagram with a pattern    or 
a solid color   . You can select from 256 colors and from a 
number of patterns, including grass, water, sand, concrete, 
and so on. Th e hatch and fi ll selections are found on the 
Draw/Snaps/Hatch section of the left -hand toolbox.

You can fi ll inside existing objects, like rectangles, circles, 
polygons, and so on, by selecting them (Hatch Selected 
command) or by clicking inside them (Pick Area com-
mand). To use this method, the object must be completely 
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closed with no gaps in the boundary. If you do not have a pre-drawn object that you want to fi ll, use the Trace 
Boundary command and trace the desired area by clicking or snapping to points with your mouse.

If you place a hatch pattern and it appears too small or too large, you can change its hatch 
scale to get exactly the look you want.  Click on an existing Hatch in your diagram, then 
right click on it and select Edit. Specify a larger Hatch Scale to make the pattern display 
larger or a smaller Hatch Scale to make it smaller, as shown by the bricks in the fi gure.

Printing Your Diagram

Th roughout this  manual it has been stressed to always create your diagrams to real-world measurements, or a 
1:1 scale. You don’t have to think about scaling your diagram to “fi t” it on your computer screen, the View com-
mands do that for you. However, when you are ready to print your diagram, then it is time to consider how you 
want to scale it to fi t onto the paper.

Selecting Print from the File pull-down menu or the Speedbar displays the Print dialog box which has a number 
of options for controlling how your diagram will appear when printed. Th e fi rst options to consider are related to 
the Print Scale:

Fit to Paper - selecting this  option fi ts the 
entire diagram on a single sheet of paper. Th e 
program calculates the scale that is necessary 
to fi t the diagram onto the size of paper that 
you have specifi ed in your printer’s settings.

Current View -  prints only the portion of the 
diagram that is currently displayed on the 
screen onto a single sheet.  If you are zoomed 
way in on some small details when you select 
the Print command, that portion of the dia-
gram is all that will be printed.

Scale –  this option allows you to enter an 
exact scale to use for printing. You enter the scale in the format:  X inches on paper = Y feet in the real world 

Print Tiling
If you use the  Scale option and enter an exact print scale, you may fi nd the diagram does not fi t on just one sheet 
of paper. If this is the case, the program will automatically “tile” the diagram by splitting it up across multiple 
sheets. For example, the diagram shown in this fi gure has been tiled onto 4 sheets with a Landscape orientation.

Just click the Print button to print all the sheets so you can tape them together to create a larger diagram. You can 
also click on any individual pages shown in the preview window and print just those pages. Place your mouse 
inside the preview window and hold down your mouse button as you move it to drag the diagram to a better 
position on the sheets of paper.

Click the Setup button to display the standard Windows Print Setup dialog box. From 
there you can select a diff erent printer, change the paper size, and choose other options 
specifi c to your printer.
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Using Your Measurements

Th e way you create a diagram depends on what level of accuracy you want to achieve and how you have obtained 
your measurements. It’s possible to just draw a quick sketch showing the relative location of objects found at a 
scene, without having any actual measurements. For a more accurate diagram, you can enter manual measure-
ments that were taken with a tape measure and you can even import measurements obtained with a total station 
or other laser measurement device.

The 10 Minute Sketch

Suppose you are writing a report for a minor crash and you need to include a diagram. You have no measure-
ments, just a couple photographs and a basic knowledge of the intersection where the crash occurred.  Here’s 
how to create your sketch  in 10 minutes or less:

Open the diagram program.  Th e “Let’s get started” toolbox should be displayed.1. 
Enter the name you want to use for your diagram. (Units and precision do not really apply because you do 2. 
not have any measurements.)

Make sure the Starting Tool 3. 
is set to “Build Intersection” 
and click OK.

Th e 4.  Easy Intersection toolbox 
is opened so you can draw 
your intersection. Th ere 
are a number of options for 
setting lane widths, placing 
crosswalks, medians, turn 
bays, and more. When you 
are fi nished with the inter-
section, click Place to put it 
in your diagram.

Select Symbols from the 5. 
left -hand toolbox, make sure 
the Crash symbol group is 
selected (at the top of the 
toolbox). 

Place symbols in the diagram 6. 
to show the vehicles 
involved, signs, north arrow, and any other details.

Close the Symbol Manager (the blue “back” arrow) and select Quick Pick from the left -hand toolbox.7. 
Select the Text command and add any notes you wish to show.8. 
Select Save from the File menu to save your diagram to disk.9. 
 Select Print from the File menu to print your diagram. Since it was not drawn to scale, select the “Fit to 10. 
Paper” option.

Once you are familiar with the Easy Intersection toolbox and placing symbols, these 10 steps can easily be 
completed in 10 minutes or less!
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No measurements? Start By Tracing!

One way to get a fast start on a diagram is to bring in a satellite image or other digital photograph and trace 
over it. Th is is a great way to draw the footprint of buildings and even intersections when you do not have exact 
measurements. 

You can use the Import Satellite Image  
feature to fi nd a satellite image of a 
building by entering its address. Import 
Satellite Image is found on the File 
pull-down menu and on the Quick Pick 
section of the left -hand toolbox. Th e 
satellite photo is placed at real world 
scale in your drawing and geo-refer-
enced accurately, allowing you to place 
GPS data directly over the top of the 
satellite photo using the Coordinate 
Data Table.

 Other images, like digital photographs , 
can be imported with the Import Bitmap  
command in JPG , BMP, and WMF fi le 
formats.  Once an image is imported, 

you can use your mouse to move and rotate the image and use the Bitmap Scale and Bitmap Edit features to scale 
the image, change it’s layer, make it lighter or darker, and so on. 

Once the image is placed in the diagram, just use the standard drawing tools (Line, Rectangle, Text, and so on) to 
trace over the sides of a building or the edges of a street. If you know just one dimension, you can scale the image 
to make sure it’s at actual size.

Import a CAD Drawing

If you need a fl oor plan diagram of a commercial building or a site drawing, it’s very possible that it is available as 
a CAD diagram  that you can just bring into Th e Crash Zone. City and County planning departments oft en have 
diagrams in electronic format which can be opened directly in Th e Crash Zone and Th e Crime Zone. Th is could 
save you many hours of measuring and drawing.

Many CAD programs can save diagrams to an industry standard format with a fi le extension of .dxf.  Th is format 
was fi rst developed by Autodesk ® (publishers of AutoCAD) and is supported by many vector-based drawing 
programs, including Th e Crash Zone and Th e Crime Zone.  CAD Zone diagram programs can also open most 
AutoCAD ® drawings in their native .dwg fi le format. Just select the Open command from the File menu, click 
the pull-down arrow for “Files of Type:” and select the desired fi le format.

Obtain Measurements From Photographs

Th ere are soft ware programs that use the technique of photogrammetry  to obtain 3D measurements  from a 
series of photographs taken at a scene.  As these programs become less expensive and easier to use, they are 
becoming more popular with crime and crash investigators. Taking a large number of photographs is oft en much 
faster than taking measurements with a tape measure or with a total station. In the case of a crash, this can mean 
getting the road re-opened to traffi  c faster than you could with other measurement methods.
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Photogrammetry programs can provide you with a large number of accurately placed points and lines, but it’s 
not nearly a completed diagram. You still must bring those points into a diagramming program, like Th e Crash 
Zone or Th e Crime Zone, to complete the diagram by adding symbols, text, dimensions, and so on.  Photogram-
metry programs typically can export the point data to a standard CAD format called a .dxf fi le. You can import 
these .dxf fi les, as described above in the section on “Import a CAD Drawing,” and complete the diagram.

Manual Measurements

If you take measurements  at a scene manually, with a tape measure or similar tool, there are some special 
features in the program that help you turn that data into an accurate diagram.  Th ese tools let you enter the 
measurements on the keyboard in a convenient format and the program places points, draws lines, or draws 
curves between the points.

Easy Lines

One way to draw from manual measurements is to use Easy Lines, discussed previously under Drawing Tools. 
Easy Lines is very easy to use; think of it like pacing off  the outside of a building. First place a starting point at 
one corner, point in the direction of the next corner, enter the desired distance and select whether to place a line 
between the two points or a “marker” (a point used to mark the location).  Continue from this new starting point 
to select the direction and distance to the next point.  Easy Lines also has specifi c modes for drawing when you 
have used a baseline or triangulation method of collecting the measurements.

Easy Lines is ideal if you do not have a very large number of points to enter, because there is no way to import 
or preview the measurements. If you want a more powerful method of entering manual measurements, try the 
Coordinate Data Table.

Coordinate Data Table

When you have a large number of points, the Coordinate Data Table  is the best way to turn your manual 
measurements into an accurate diagram.  Th is feature has a spreadsheet-like table where you enter your 
measurements.  You can choose to just place points or enter special codes that instruct the program to connect 
the data points with lines and curves. As you enter measurements, a preview of the diagram is displayed in a 
window below. Th is allows you to make sure all your points are correct before you commit to placing them in the 
diagram.

Depending on how you obtained your measurements, you can enter data in the Coordinate Data Table in a 
number of diff erent formats, including baseline, triangulation, X Y Z coordinates, multiple laser device formats 
(i.e. Pt#, North, East, Elev, etc.) and GPS formats.

You can open the diagram program and type the measurements directly into the Coordinate Data Table, or you 
can enter your data into a spreadsheet program, like Microsoft  Excel®. If you choose to enter your measure-
ments in some other program, you must type the information so that each row represents one point and the 
columns are ordered according to one of the standard data formats. Select “Formats” on the Coordinate Data 
Table to see the choices. When you fi nish entering data, save it with an ASCII text fi le with a fi le format of .txt, 
.csv, .dat, or .asc. Open the Coordinate Data Table and click the Open button to bring in your data. 

See the section below on importing measurements from lasers for more information on the Coordinate Data 
Table.
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Measurements From Laser and GPS Devices

Many crash and crime scene investigators now have access to a total station  or other laser measurement   devices, 
like those available from Laser Technology, Inc . Th ese devices normally take special training to learn to use, 
but they allow you to collect more accurate measurements of a scene much faster than you can with manual 
methods. While collecting and recording accurate measurements is critical, you still need an easy way to turn 
those measurements into a 2D or 3D diagram and maybe even into a 3D animation.

Th e Crash Zone and Th e Crime Zone can import the data from nearly all laser measurement devices, automati-
cally turning your measurements into a diagram of points, lines and curves.  Th ere are diff erent tools available 
to help you bring your data into the diagram program, depending on which laser device you use and which data 
collection soft ware.

Collect Your Data With Pocket Zone

Pocket Zone  is a data collection soft ware  program that runs on a Windows CE handheld computer. When 
connected to a total station or other laser measurement device, Pocket Zone records the measurement data for 
each point you shoot and creates the diagram as you go. You can instantly see if a signifi cant data point is missing 
or was shot incorrectly. 

Th e diagrams you create in Pocket Zone can be uploaded to your desktop computer and opened with Th e Crash 
Zone or Th e Crime Zone. Th ere you will see all the exact points you shot with your laser including any lines, 
curves, and symbols that you added at the scene.  Once in the diagram program, you can use the standard 
drawing tools to edit and delete objects, add more symbols, and place additional text and dimensions.

Pocket Zone is one of the best ways to get perfectly accurate measurement data into the diagram program. To 
learn more about how Pocket Zone can make it easier to get results from your laser, visit Th e CAD Zone’s website 
at:  www.cadzone.com

Raw Import From Many Devices

Every manufacturer of laser measuring devices has developed a proprietary data format for their output. Th e 
Crime Zone and Th e Crash Zone can directly import  the  measurement  data from many devices in their native 
format. Follow the instructions below to bring in data from these devices in their native format:

Laser Technology’s .raw fi les - Select the Open command from the File menu, click the pull-down arrow   
for “Files of type:” and select “LTI fi les”

Sokkia’s SDR format -  Select SDR Download or SDR ASCII import from the File menu.
Nikon AIMS devices – Th ere is a special Crash Zone AIMS version of the diagram program that allows for 

direct import of data from Nikon AIMS devices.

ASCII Import From All Other Devices

Besides having a native format, nearly every device can also save the measurement data to an ASCII, or plain 
text, format.  If you are not using one of the devices listed above that allows for raw data import, you can still 
easily bring your laser measurements into the diagram program using the Coordinate Data Table. Th e Coordinate 
Data Table  is ideal for bringing in data that was collected with a total station or other laser measuring device. Just 
use your device to save your measurement data as an ASCII text fi le with a fi le format of .txt, .csv, .dat, or .asc. 
Open the Coordinate Data Table and click the Open button to bring in your data. 
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Depending on how you obtained your 
measurements, you can display data in 
the Coordinate Data Table in a number 
of diff erent measurement formats. Laser 
devices commonly export their data 
in formats like: Pt#, North, East, Elev.  
Click the Formats button at the top of 
the toolbox to see the format choices.

When bringing in 
measurements, it 
is critical that 

you select the correct data type, or 
format. If the wrong data type is 
selected, the points will not be placed in 
the correct location!

In the Coordinate Data Table, a line is always placed between all points with the same description.  As you collect 
your data, you can use any description you want, such as EP1 for one side of the road edge pavement and EP2 for 
the other side. Once the points are shown in the table, you can edit the point descriptions to change which points 

are connected with lines 
and where arcs and curves 
start.  Place your mouse in 
the Desc. (Description) fi eld 
and click your right-mouse 
button to display a list of 
special line control codes 
used by the program. Th e 
lower portion of the list 
shows all the point descrip-
tions currently used, such as 
codes that were assigned to 
points when you collected 
the measurements.
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Append the following descriptions to the initial point description to connect those points with curves and arcs, 
instead of lines: 

SC – Creates a Spline (fi t) curve through all the following points that 
have the same description, ending where the EC code is encountered. In 
the example shown here, points 510, 511, 513, 514, and 515 are connected 
with a curve. 
EC - Ends the curve sequence and goes back into straight line mode.
CL – Use Close Label to automatically connect back to the point with 
the same description to create a closed shape. Th is is ideal for fi nishing a 
building, vehicle, or other shape. 
A3 – Draws a 3-Point Arc, starting at the point where A3 is appended to 
the description, and connecting to the following two points of the same 
description.
R – Resolve calculates a fourth corner for you and closes the shape.

If you make changes in the table, be sure to select Save from the Coordinate Data Table 
toolbox to save your measurement data as a new text fi le (before you Place it). If you fi nd 
some data was not complete or needs to be edited, you can simply start a new diagram, 
open the Coordinate Data Table and bring the information in again.

When you’re satisfi ed with the diagram as it appears in the preview window, click the Place button to place the 
points, lines, and curves in the drawing window. If you have an existing diagram open, the points, lines, and 
curves you created in the Coordinate Data Table are shown as a rectangle attached to the mouse pointer. Click or 
snap where you want to place these objects into your diagram.

Once the data is placed in your diagram, you can use the program’s standard editing 
commands to modify it. Th e points, lines, descriptions, point numbers, and point eleva-
tions are all placed on separate layers. If the diagram seems too cluttered, use the Layer 

Manager to turn off  the display of some layers, such as the elevations, so you can see your points more clearly.

Creating a 3D Model

We don’t want investigators to spend weeks or months learning to draw three-dimensional objects while 
looking at a two-dimensional computer monitor, so all drawing and editing in Th e Crime Zone is done in 2D. 
Th e program takes care of building an accurate  3D  model from your 2D drawing. Once your 2D diagram is 
completed, select the 3D Viewer icon from the right of the Speedbar. Your diagram appears in a 3D view with the 
line types (like cones, fences, and guardrails) and symbols converted to 3D. If you used the 3D Builder feature 
to assign heights to any objects, like walls of a building, these will also show in 3D. Return to the 2D Drawing 
Window (close the 3D Viewer) to make changes and additions to your drawing.

Start in 2D

To build a 3D model, just create your diagram in the 2D Drawing Window, as you normally would. Place text, 
symbols, and line types to show the details of your scene. Th ese are all converted to a 3D model automatically.  

Objects that you draw with basic entities, like lines, rectangles, and arcs, must be 
assigned a height and elevation (if desired). Th is includes building outlines that 
you draw with the Easy Builder tool.
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To assign a height to the walls of a building, follow 
the steps in this fi gure. Draw the building in 2D, 
select the entire building, and use the 3D Builder 
feature to enter the wall height, whether to “paint” the 
walls and roof with a color, and which colors to use.

You also use the 3D Builder   feature to assign an 
elevation to an object which raises it above the 
ground.  Suppose you want to show a body lying 
on a bed. First use the Body Poser feature to draw a 
3D body, select the body and open the 3D Builder 
toolbox.  Enter a value in the “Elevate” box of  2’ 8” to 
raise the body that far above the ground. When this 
body is placed over one of the bed symbols in 2D, it 
will be lying on top the bed when viewed in 3D.

Continue to construct your scene in the 2D Drawing Window and use 3D 
Builder to assign the height and elevation to each object, as needed.  Click the 
3D Viewer icon to see your diagram in a 3D view. Return to the 2D Drawing 
Window to make additions and changes to the diagram.

 Th e 3D Builder tool was used to assign a height and give a diff erent “paint” color to the rectangles in the 2D 
diagram, creating the gas pumps and the roof over the pumps. Th e symbols (motorcycle and car), body, and 
fence linetype were converted to 3D automatically by the program.

Viewing Your Diagram in 3D

 Once your diagram is opened in the 3D Viewer, there are four things that you can do there:

1. Manipulate the view of the scene using the various navigation tools available. 
2. Take Snapshots, or images, of the scene. 
3. Change the 3D Preferences used to set options for rendering, colors, and navigation. 
4. Return to the 2D diagram window for further editing and viewing of snapshots. 

Th e fi nal diagram as it looks in the 2D drawing window and in the 3D Viewer. 
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Th ere is a smaller window in the upper-left  of the 3D Viewer screen 
that shows a “2D Camera View.”  You can modify the view by 
moving the two target symbols in this 2D preview. Th e green symbol 
represents the “target,” or the point where you are looking. Th e red 
symbol represents the location of the camera. You can enter an 
elevation above the ground for both of these targets on the speedbar 
at the top of the screen.

You can also modify the view of the 3D model by using the various 
commands at the top of the screen and by dragging your mouse up 
and down, or side-to-side. To get this view, we used a combination 
of the Zoom In command and dragging the mouse side-to-side to 
rotate the view. Once you have created a 3D model, experiment with 
the various viewing methods to see how it changes.

You can use any soft ware program that takes  screen shots  to capture 
your 3D view, or use the diagram program’s built in Snapshot 
feature. When you have a 3D view you want to capture, click the 
camera icon on the speedbar and the image is saved as a .jpg fi le 
on your computer. Take as many snapshots as you want of diff erent 
views of the scene. When you return to the 2D Drawing Window, 
the Snapshot Manager will be open so you can view and manipulate 
your snapshots. You can also open your snapshots in any graphics 
program that can edit .jpg image fi les.
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Tools for Drawing Crash Scenes

In addition to all the general drawing and editing features, the diagram program also has a number of tools 
specifi cally for drawing streets, intersections, and   crash scenes. Th roughout this section, we will refer to features 
of Th e  Crash Zone, but remember, Th e Crash Zone and Th e Crime Zone are really the same soft ware applica-
tion! You can use both programs equally well to draw all types of scenes. All the tools discussed here for drawing 
crash scenes are also available in Th e Crime Zone.

As noted previously, the purpose of this manual is to introduce you to many of the important tools in Th e Crash 
Zone so you know what is available to you. For detailed descriptions of how to use each of these tools, refer to 
the electronic help.

Pre-drawn Symbols

Th e Crash Zone includes thousands of  symbols that have been pre-
drawn for you so they are ready to use in your crash scene diagrams.  
Symbols are included for cars, trucks, emergency  vehicles, motorcycles, 
cones, barrels, signs, trees, shrubs, bodies, weather indicators, and 
more.

To place one of these symbols, select Symbols from the left -hand 
toolbox, then select the Crash symbol group from the list at the top of 
the toolbox. A number of symbol categories are shown, such as Quick 
Pick, Vehicles A, Vehicles B, Traffi  c Ctrl, Signs, and so on. Clicking 
on one of these categories displays the sub-groups of symbols that are 
available. In this example, selecting the Vehicles A category displays the 
sub-groups of symbols: Cars, SUV’s, Vans, Pick Ups, Trucks 1, Trucks 
2, Motorcycles, Recreational, Emergency, and Parts. 

Th e symbols for the selected group are shown on the toolbox. Use the 
scroll bar or arrows on the right side of the toolbox to scroll through 
the symbols in that sub-group. Click on the one you want to place in 
the diagram, using the options at the bottom of the toolbar to adjust 
how the symbol is to be placed. See the previous section on Drawing 
and Editing for more information on how to place symbols.

If you need to place clothing, furniture or other crime-scene related 
symbols in your diagram, select the Crime Symbol Group from the top 
of the toolbox. If you don’t fi nd a symbol for what you want to show in 
your diagram, just use the drawing and editing commands to draw it. 
Once drawn, you can create your own symbol for that item and save it 
to use in other diagrams.
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Drawing Streets and Intersections

Oft en the fi rst step of drawing a crash scene is to draw the  street or    intersection where the crash occurred. Th e 
Crash Zone contains three special tools to help you with this task:

Templates1.  - A large number of road sections and intersections have been pre-drawn for you and can be 
selected with the Templates button on the left -hand toolbox. You can even create your own templates of 
intersections in your area and save them to the Templates toolbox to use in future drawings.

Easy Intersection toolbox2.  - Th is toolbox is an amazing feature for drawing simple or complex intersec-
tions. You simply use your mouse to select from the many options to add to your intersection, such as the 
number of lanes, crosswalks, medians, turn lanes, bus turnouts, and more. 

Easy Streets3.  – Th is tool lets you turn any continuous line, curve, or arc into a multi-lane street. You defi ne 
the width of each lane and the type of centerline between the lanes.

Using Templates
Templates are just sections of roads, intersections, 
highway interchanges, and other items that have 
been predrawn and included in the program. You 
can select the  template you want to use, mirror it, 
rotate it, and place it in your diagram.  All templates 
are drawn to actual measurements, or a 1:1 scale.

 Th e “Save Template” button takes everything in 
your current diagram and turns it into your own 
template.  Suppose you use a total station to take 
measurements and you create an accurate diagram 
of a complex intersection for a crash. Chances are 
good there will be another crash there in the future, 
so save it as a Crash Zone Template and share it with 
other investigators in your department.

When you select “Save Template,” you are prompted 
to give the template a name and it is saved as a fi le 
on your computer’s hard disk. You can select it from 
the Templates toolbox from the “My Templates” 
folder. You can copy this fi le to other computers 
so other diagram program users can use it in their 
diagrams. Templates are normally saved to this 
folder:

C:\My Documents\My Cad Zone\Templates\My Templates

To change the location for Templates and other fi les, select the Utilities pull-down menu and then select Settings. 
Click the “Paths” tab to change the fi le path for a number of diff erent types of fi les used by the diagram program.

The Easy Intersection Toolbox
As the name implies,  Easy Intersection is a tool that let’s you easily and quickly create a diagram of an intersec-
tion. First, choose which road sections to use, how many lanes in each section, and the width of each lane. Next, 
use your mouse to select from the many options to add to your intersection, such as crosswalks, medians, bus 
turn-outs, turn lanes, and so on.
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Th e best way to learn to use Easy Intersection is to just click on everything and try to create diff erent types of 
intersections.  You can select one of the templates on the right side of the toolbox to start your intersection. Place 
your mouse pointer on the red dot at the end of a lane, hold down the mouse button and drag that road segment 
to a new angle. You can also uncheck any road segment to turn it off . 

Here is a summary of the features on the Easy Intersection Toolbox:

1. Preview Window – Shows how your intersection will look as you add features to it.
2. Number of lanes - Click the arrow buttons to increase or decrease the number of lanes on this road section. 

Uncheck the box to eliminate that road section completely.
3. Templates – You may want to choose one of these predrawn templates on which to base your intersection.
4. Lane Properties – Change the width and centerline type for each lane.
5. Roadway Features – Select any lane in the intersection and then select one or more of these features to add 

to that lane, such as turn lanes, medians, bus turn outs, and so on.
6. Street Length and Button Bar – Use this slider bar to adjust the overall length of the streets in the intersec-

tion. Th e Options button brings up a number of default settings that you can adjust. Click the “Place” 
button to insert the intersection, just as it appears in the Preview Window, into the diagram.

You can click your right-mouse button on any lane to see what options are currently in 
place.  Clicking an option on the list will toggle it on or off  for that lane.

Easy Streets

Suppose you used a laser to measure one edge of a road and you bring your data points into Crash Zone with the 
Coordinate Data Table.  You can use the description codes to connect the points with a curve to represent one 
edge of the road, but how do you draw the rest of the road? Th e   Easy Streets toolbox lets you select any curve, 
line, or arc and turn it into a multi-lane street.
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With Easy Streets, you select the number of 
lanes, the width of each lane, and the type 
of centerline to use, essentially building 
a model of the entire road. A preview of 
your road appears at the top of the toolbox. 
When you are satisfi ed with the preview, 
click the Apply button to place it in the 
diagram.

You can choose whether to make the 
original line one edge of the road or the 
centerline. Other features on the toolbox 
allow you to fl ip the model to make a mirror 
image of it, to reset all the values so you 
can start over, and to trim lines that run 
through an intersection. 

Once you build your model in the Easy Streets toolbox, the settings remain in aff ect. Th at 
means you can “apply” the same lanes and centerlines to multiple curves and lines that are 
connected. Just draw one entire edge (or centerline) of the road, then select each line, 

curve, or arc individually and click Apply on the Easy Streets toolbox.

Vehicle Specifi cations Database

Th e Easy   Vehicle Database gives you access to 
measurements and other specifi cations for a large 
number of  vehicles sold from the year 1971 to 
present day. You select the year, make, and model 
of a vehicle and the toolbox creates a rectangular 
outline of it using the actual length, width, height, 
and wheelbase values found in the database.

You can choose to show the vehicle’s center of 
gravity, wheel base, and wheel centers. You can also 
choose to display the data as text in the diagram.

Once you select the desired vehicle from the data-
base, click the Place button to place a simple symbol 
with that exact size into your diagram.  If you want 
to use a more realistic vehicle symbol, select one 
from the  Symbol Manager. Place the desired symbol 
on top the rectangular one and use the selection 
handles to drag it to match the size of the rectan-
gular symbol, as shown in the fi gure, below.

If you intend to create a 3D model of the vehicle you must also assign a height to the symbol. To do this, select 
the new symbol and click the 3D Builder button on the toolbar at the top of the screen. Enter a Symbol Height to 
match the height of the actual  vehicle, as listed in the Vehicle Database.
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Th e Vehicle Specifi cations Database is updated regularly. To keep he database on your 
computer current, open the Vehicle Database and click the “Check for Updates” button. 
Updates are always free!

Reconstruction Tools

Th e Crash Zone includes several special tools just for  crash  reconstructionists. New tools are frequently being 
added (like Crush Calculations) and existing tools are always being improved. Refer to the electronic help for 
more information on how to use all of these special features.

Four of the tools are for reconstructionists who want to use measurement data to determine vehicle speeds: 
Skid Analysis, Momentum Angle toolbox, Momentum Calculator, Combined Speeds Calculator. First use your 
measurements to create an accurate diagram of the crash with pre- and post-collision positions, then use the 
Reconstruction Tools to estimate the speed of the vehicles involved.

Th e Crash Zone performs these calculations 
using industry-standard formulas, but your 
results are only as  accurate as your drawing! You 
must ensure that your measurements are accu-
rate and the skid marks and vehicle locations in 
your diagram are drawn to those exact measure-
ments! Refer to the electronic help for more 
information on how to use these special features.

Skid Analysis
Use the  Skid Analysis toolbox to calculate pre 
and post-impact speeds based on skid marks. 
Th is calculation takes into consideration braking 
effi  ciency and the change of drag factor (friction) 
across multiple surfaces. 
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Momentum Angles
Use this toolbox to determine the 
approach and departure angles of 
vehicles in a collision. Th e data is 
saved and used in the   Momentum 
Calculator to determine impact 
speeds. Th e formulas used by the 
Momentum Calculator require that 
vehicle 1 have an approach angle 
of either 0 or 180 degrees. In most 
cases, your diagram will not be 
drawn that way, so the Momentum 
Angle toolbox adjusts all the 
angles automatically, as shown in 
red, below the “Adjusted” column 
heading.

Momentum Calculator
Th e Momentum Calculator uses the information from the 
Momentum Angle Toolbox and the Skid Analysis tool to calculate 
impact speeds. Th e weight of the vehicles is also required, which is 
obtained when you select the vehicles from the Vehicle Specifi ca-
tions Database.

Combined Speeds
Determines  combined speeds using data determined in the Skid 
Analysis and Momentum Calculator toolboxes.
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Creating 3D Surfaces

Since crashes rarely happen on completely level ground, Crash Zone and Crime Zone have features for creating 
accurate  3D  surfaces such as road surfaces, hills, and ditches. Th e Easy Surface command allows you to defi ne 
each surface by manually snapping to three points.  Use the Auto Surface command to have the program auto-
matically connect a large number of points on a surface, such as may have been acquired with a laser measure-
ment device.

Easy Surface
A minimum of three points are 
required to defi ne a 3D plane, or 
surface. With the  Easy Surface 
command, you snap to any three 
points in the diagram, creating a 
triangle. Th e elevation and slope of 
the triangle is defi ned by the loca-
tion of the three points in 3D space. 
To complete the surface, you create 
a series of these triangles, connected 
together, to cover the entire area. Th e 
resulting 3D surface is shown as a 
special Fill placed within the triangles. 

Once the fi rst triangle is created, Easy Surface automatically creates the next triangular section between the 
previous two points (points 2 and 3 in this example) and the next point you select (point 4). Press Enter to 
complete the surface when it is completely covered with triangles. Open the 3D Viewer to see your surface in 3D.

If you make a mistake when selecting a point, just press the Escape key on your keyboard 
to cancel the last point so you can select a diff erent one.

Auto Surface
Use  Auto Surface to create surfaces between any selected points, lines, or curves with one click. A series of 
triangles will be placed to connect the selected entities. With Auto Surface you will either be surfacing between 
selected points, selected lines, selected curves, or a combination of the three. 
 
Auto Surface is great for connecting a “cloud” of points that were collected with a laser measurement device  to 
defi ne terrain like a hillside or ditch. Th e program automatically connects all of the points with triangles to form 
a complete surface with no gaps.  

Surface Settings
Use the Surface  Settings feature to select options for the surfaces you create with Easy Surface and with Auto 
Surface. From this toolbox you can control the surface color, layer, whether to show facets, and more.  

Some of the settings only apply when you are using the Auto Surface command. You can adjust the Surface 
Density when using Auto Surface to create a surface between lines and curves, instead of points. A smaller 
Surface Density value will result in more triangles created to make up the surface. Th is makes it look smoother 
but will be slower to redraw. Th e Triangle Minimum Angle and Triangle Maximum Angle can be used to prevent 
the creation of unwanted triangles that sometimes result when a large area is selected to be covered with a surface.
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Sample Diagrams

Here are some 2D and 3D crash scene diagrams that have been created with Th e Crash Zone. 
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Tools for Drawing Crime Scenes

In addition to all the general drawing and editing features, the diagram program also has a number of tools 
specifi cally for drawing crime scenes  including buildings, posed bodies, evidence and more. Th roughout this 
section, we will refer to features of Th e Crime Zone, but remember, Th e Crash Zone and Th e Crime Zone are 
really the same soft ware application! You can use both programs equally well to draw all types of scenes. All the 
tools discussed here for drawing crime scenes are also available in Th e Crash Zone.

As noted previously, the purpose of this manual is to introduce you to many of the important tools in Th e Crime 
Zone so you know what is available to you. For detailed descriptions of how to use each of these tools, refer to 
the electronic help.

Pre-drawn Symbols

Th e Crime Zone contains thousands of symbols that have been drawn for you so they are ready to place in your 
diagrams.  Symbols are included for doors, stairs, residential and commercial furniture, evidence items like 
clothing and footprints, weapons, shell casings, and more.

To place one of these symbols, select Symbols  from the left -hand 
toolbox, then select the Crime symbol group from the list at the top of 
the toolbox. A number of symbol categories are show, such as Building, 
Home, Offi  ce, Evidence, and so on. Clicking on of these categories 
displays the sub-groups of symbols that are available. In this example, 
selecting the Evidence category displays the sub-groups of symbols: 
Clothing, Drugs, Toys, Examine, Misc, and Sundries.

Th e symbols for the selected group are shown on the toolbox. Use the 
scroll bar or arrows on the right side of the toolbox to scroll through the 
symbols in that sub-group. Click on the one you want to place in the 
diagram, using the options at the bottom of the toolbar to adjust how the 
symbol is to be placed. See the previous section on Drawing and Editing 
for more information on how to place symbols.

If you need to place vehicles or other traffi  c related symbols in your 
diagram, select the Crash Symbol Group from the top of the toolbox. 
If you don’t fi nd a symbol for what you want to show in your diagram, 
just use the drawing and editing commands to draw it. Once drawn, 
you can create your own symbol for that item and save it to use in other 
diagrams.

Tools for Drawing Crime Scenes
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Body Poser

Body Poser is an easy-to-use toolbox for creating and posing realistic 3D bodies  in your diagrams. Th e 
 Body Poser toolbox allows you to automatically create and pose a body by selecting pre-set options and then 
manipulating a wire frame “stick-fi gure” to position it in 3D space. When fi nished, a realistic 2D plan view of the 
posed body is placed in the diagram. When you go to 3D mode, the 3D model of the body is shown, just as you 
posed it in the toolbox.

Th e left  side of the toolbox has options for gender, height, build type, skin tone, clothing color, head rotation, 
and elevation above the ground (if, for example, the body is lying on a bed). Th e right side has basic poses from 
which you select to start creating the body. Th ree of the center preview windows show the body as a “stick fi gure” 
with green circles at the joints. If you use your mouse to drag one of the joints to a new location, the view of the 
3D body is updated to show the change. 

You can also use the other buttons on the right-side of the toolbox to change the view of the 3D preview. Click 
the Save button (lower-left  of the toolbar) to name and save your pose so you can use it again.

When you’re satisfi ed with how the body looks, click the Place button to place it in your diagram. In 2D, the 
body will appear to be composed of a large number of circles.  Th ese will become smooth surfaces when you 
view it in 3D.
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Drawing Buildings

There are several tools included to make it faster and easier to draw  buildings  and add doors, windows, 
and rooftops. The Easy Builder toolbox is an easy-to-use method for creating basic 2D building out-
lines in your diagrams. It allows you to create a building footprint by clicking and selecting the various 
options on the toolbox.  

To start, choose one of the basic building shapes on the left -side of the toolbox. You can either type in the length 
of each wall, as labeled in the preview window, or you can use your mouse to drag walls to a diff erent length. To 
change a wall’s length in the preview window, place your mouse pointer on one of the letters in a green box, hold 
down the mouse button and drag. As you start to move the mouse, the length of each wall is shown. When the 
wall you are moving has the desired length, let up on the mouse button.

Other options on the Easy Builder toolbox include buttons on the upper-right to rotate the building 90°, to 
mirror it, and to show dimensions instead of the letter labels on each wall.  Th e slider bar lets you quickly change 
the overall length of the building. You can also choose to show dimensions and some fi elds of “Building Text,” if 
desired. 

When you are satisfi ed with the building, click the Place Building button to place it in the diagram. Th e outline 
is drawn as one continuous shape, so you can easily move it, rotate it, or assign a wall height to it with the 3D 
Builder  command.  You can use Easy Lines to quickly place markers and draw lines for interior walls. 

Th ere are other tools for adding a roof and for placing doors and windows in your building. Th ere are also a large 
number of predrawn symbols in the Crime Symbol Group which you can use to show building details, such as 
diff erent doors, stairs, elevators, furniture, cabinets, and more.
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Easy Stairs and Ramps

Since it can be diffi  cult to draw 
stairs in 3D, the Easy Stairs toolbox 
was created. Th is is an easy-to-use 
tool for building stairs , ladders, and 
ramps in 2D and 3D.  On the right 
side of the toolbox are fi ve pre-
drawn templates from which you 
choose a basic shape. In the upper-
left  of the toolbox are check boxes 
where you select whether to draw 
stairs or a ramp. If you have exact 
measurements, you can enter values 
for rise, tread and width of the steps, 
as well as the height and length of 
the stair case. Landings and diff erent 
railing types can be added with just 
one mouse click. 

Once the stairs are placed in the 
drawing, you may explode and mod-
ify them; the changes will appear in 
3D without losing the 3D properties.

3D Wall Evidence

Since drawing and editing in Th e Crime Zone is always done in 2D, how can you show evidence, like blood 
spatter on a wall or other vertical surface? Th e Wall Evidence tool, found in the 3D   Tools group of the left -hand 
toolbox, gives you this ability. You can use Wall Evidence to show blood, fi ngerprints, bullet holes, and other evi-
dence on walls, furniture, cabinets, and so on. It’s also great for making custom road signs or adding text to sides 
of buildings and vehicles. You can even use it to place an image or digital photograph onto a vertical surface.  

You can use Wall Evidence to show objects on the front of a counter, back of a sofa, or on 
the side of a vehicle. First, create a small “false wall” where you want to show the evidence 
by drawing a line and giving it a height and elevation. Show the evidence, text, etc. on the 
false wall. When done delete the wall and the evidence, text, etc. will remain.

If you have digital photographs of the scene, you can use Wall Evidence to place the photo 
on a vertical surface, such as placing a photograph of the front of a building on a wall. Th is 
is also an easy way to show street signs or other landmarks that you have photographed.

First create a “false wall” where you want to show the photograph by drawing a line and giving it a height and 
elevation. Start the Wall Evidence command, select the wall and use the Import Image feature (on the File pull-
down menu) to select the photograph and place it on the wall. You will only see the image when you go into the 
3D Viewer!
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To place symbols, text or other objects on 
a vertical surface:

1. Create your 2D diagram, then use 
3D Builder  to assign heights to the 
walls (or lines) where you want to 
draw.

2. Select 3D Tools from the left -hand 
toolbox and then select the Wall 
Evidence  command (red icon 
with an E).

3. Click on the desired wall (or line 
with a height applied). 

4. Click to show which side of the wall 
you are facing, which is the side 
where the evidence is to be drawn.

Th e drawing window is then split, with the 2D view shown below and an elevation view of the selected wall 
shown above.

5. Draw your evidence on the upper window, us-
ing the standard 2D drawing tools, including 
symbols, text, hatch patterns, and so on. You 
can even place an image or photograph on 
the wall.

6. Click the Finish button when you are through 
drawing on the wall.

7. Th e standard 2D drawing window is displayed. 
A Wall Evidence icon is displayed on the wall 
to show that something has been drawn on 
that surface.

8. Select the 3D View button to see your diagram 
in 3D, including the objects that were drawn 
on the wall.
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3D Trajectories

If you take accurate, three-dimensional measurements of bullet entry 
and exit points in walls or other vertical surfaces, you can use them to 
draw a trajectory    in Th e Crime Zone.  Th e accuracy of any trajectory 
depends on the accuracy of the measurements of at least two bullet 
entry or exit locations. Th ese measurements may have been taken 
manually, recorded by a laser device and data collector, or obtained 
through photogrammetry.

1. In the 2D view (plan view) of the diagram, use the Point feature 
to mark the locations of bullet entry and exit points, as mea-
sured at the scene. For example, a bullet passes through a wall, 
a window and wall, or through furniture.

2. Next, assign a 3D elevation to each point, which is the distance 
that point is above the ground. Click on one of the points to 
select it (or place a selection window around it), select the 3D 
Builder command from the upper-right of the Speedbar, and 
enter the elevation measurement for that point. Repeat this for 
the second point.

3. Select Line Types from the left -hand toolbox, scroll down the 
list and choose one of the "Trajectory" linetypes. Th ese line-
types display well in a 3D View.  

4. Turn on Auto Snap and draw a line between the two points, 
snapping exactly to each point. 

5. To extend the trajectory line away from the measured points, 
use the “Trim & Extend” tool which is on the Quick Pick sec-
tion of the left -hand toolbox, as follows:

 a. Select Trim & Extend. 
 b.Click on the trajectory line near the end you wish to extend.
 c . Click your mouse away from the line, or click on an object 

in the diagram and the line is extended towards it. Since the 
two endpoints remain in the same location, the angle of the 
line is not changed.

  d. Repeat these steps to extend the other end of the line.

 
Once the trajectory line is drawn, there are two methods you can use 
to measure the height of any point along it:

Using AutoSnap (or some other Snap command), draw a Point entity exactly on the trajectory line at the 1. 
desired location. Place a selection window around the newly placed point to select it, place your mouse 
pointer on the point, and read the 3D Elev data on the Message Bar (the yellow bar at the bottom of the 
screen). 
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Alternatively, you can fi nd various measuring post symbols 2. 
by selecting the "North +" symbol group, then selecting the 
"Elev Posts" sub-group. In the 2D drawing window, place an 
elevation post symbol next to the trajectory line. Open the 3D 
Viewer and select a "fl at" side view that allows you to read the 
height of the desired point as shown on the post. In Imperial 
units, the post is divided into 1' sections which are divided 
into 1/10' increments.

Sample Diagrams

 Some 2D and 3D sample diagrams are included here to show what others are doing with Th e Crime Zone.
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Animation Tools

Th e Crash Zone and Th e Crime Zone give you the ability to quickly create a movie that shows the motion of 
vehicles, people, bullets, or anything you can depict as a symbol. Th ese   animations are realistic depictions of the 
event, based completely on the accurate data you measure at the site.  

Th e animations you create in Crash Zone and Crime Zone are NOT a  simulation of an 
event. Th ey do not take into aff ect weather, center of gravity of a vehicle, or other scientifi c 
facts that would be required to predict how the objects moved. Th e accuracy of these 

animations is completely dependent on the data you enter for the location, orientation, and speed of the objects 
at each moment. It’s up to the investigator to enter the correct information in order to create a correct animation.
 
Once you have measured the scene and created your diagram, there are just fi ve easy steps to create a courtroom-
ready animation. Suppose you want to animate the movement of a vehicle:

Using the measurements taken at the scene, use lines arcs and curves to 1. 
draw the path that the vehicle travelled. Th is can be a 2D or a 3D path.

Select “Add KEP” from the Recon/Animate portion of the left -hand toolbox 2. 
or from the pull-down menu.  Make sure Autosnap is turned ON, and 
snap to the start of the animation path to place a  Key Event Point (KEP) 
there. Th e  KEP dialog box appears. Enter the data for this KEP and click 
the Apply button.  

Add more KEPs by snapping them to points on the animation path where 3. 
you know changes to the speed and/or rotation of the vehicle took place. 

Place the symbol you want to animate (a vehicle, for example) on the start-4. 
ing KEP. Leave the starting KEP with zero rotation and the program will 
initially align the symbol to the animation path. You may want to snap 
vehicle symbols at each KEP so you can verify the symbol’s position as 
it progresses through the animation. Place these reference symbols on a 
separate layer so you can hide them later.

Th at completes your animation (be sure to save it!). To watch it, select the Recon/Animate pull-down 5. 
menu and select “Animate.” View buttons at the top of the screen allow you to adjust the view. Click the 
“Play” button in the lower-left  of the Animate window to watch the animation.
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KEPs Are the Key!

How the symbol moves through the animation is completely defi ned by placement of the KEPs – Key Event 
Points. Th e Recon/ Animate section of the left -hand toolbox has commands to Add KEPs, Edit KEPs, Sync KEPs, 
Remove KEPs, and a KEP Manager 
that lets you review each of the 
values for every KEP.

Yaw Values
Th e yaw value of a symbol is relative 
to the angle of the animation path 
at that point. A yaw of 0° means the 
symbol will move exactly aligned to 
the animation path. If the yaw is 90°, 
the symbol will be perpendicular to 
the animation path as it moves along 
it. If the animation path has multiple 
segments, place a KEP at the start of 
the new segment with a yaw value 
that is relative to the new segment.

Showing a Crash
 To show a crash, say of two vehicle symbols, you can “synchronize” their KEPS at the point of collision. Th is tells 
the animation program to make those 2 symbols pass through those points at the same time.
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Editing KEPs
All the tools for working with KEPs are found on the Recon / Animate portion of the 
left -hand toolbox. To edit an existing KEP, click on it to select it and then select the 
Edit KEP tool. You can also right-click on any KEP and select Edit KEP from the pop-
up menu that is displayed.

Th e KEP Manager lets you view the data associated with all the KEPs on a particular ani-
mation path. Select any KEP and select KEP Manager from the Recon/Animate toolbox. 
You can also edit the values associated with KEPs in the KEP Manager.

What Came First, the Symbols or the Path?

When you want to show an animation with complex rotations on 3D surfaces, it may be best to place symbols 
in the diagram fi rst, before you draw the animation path. Using the measurements you collected at the scene, 
place  symbols in the diagram at each location where there is a change in speed or 
rotation and then draw the animation path through the symbol centers with the Snap 
to Symbol Center command (Auto Snaps must also be turned on). Just draw the 
animation path with lines, arcs, or curves, using “Snap to Symbol Center” to attach 
the path exactly to each symbol. Finally, snap a KEP to the center of each symbol and 
enter the values for that location.

If your measurements make it more convenient to draw the animation path fi rst, the next step is to place symbols 
exactly on the path at the key locations (where changes to speed and rotation took place). Start by temporarily 
placing the symbol anywhere in the diagram, turn on Auto Snaps AND Snap to Symbol Center, then use the 
Move (MV keyboard shortcut) command to grab the symbol’s exact center and snap it exactly onto the path at 
the desired point.

To use Snap to Symbol Center, you must have Auto Snaps also turned on! If you are mov-
ing symbols onto an existing path, you may see the symbol jump onto a nearby symbol, 
instead of where you intended to place it.  To prevent this, once you start the Move

command and snap to the symbol’s exact center, to grab it, turn Snap to Symbol Center off  so you can snap the 
next point onto path and not to a nearby symbol.

Animation Viewer

Once you have established an animation path and placed a symbol at the Starting KEP, you can view your 
animation in the Animation Viewer. You will not be able to open up the Animation Viewer until you place a 
starting KEP and place a symbol on it. When you start your animation, normally all the objects that have been 
placed on starting KEPs will move at once. It is possible to only show the animation of an individual object by 
selecting that symbol before you open the Animation Viewer. 
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Th e Animation Viewer has a number of command 
icons at the top of the screen for changing the view 
of the scene.  Th ese work exactly the same way that 
they do in the 3D Viewer. You can also hold down 
the left -button of your mouse and drag it up and 
down or left  and right to change the view, just as you 
do in the 3D Viewer. 
Th e Animation Viewer has standard movie play 
buttons at the bottom, including Play, Pause, Stop, 
Step Forward, Step Backward. It also has commands 
to loop the animation continuously, watch it in 
reverse, take a snapshot, and save it as a movie .wmv 
fi le. Once you watch your movie, if it’s not what you 
intended, close the Animation Viewer and modify 
the KEPs, symbols, and animation path as needed to 
make it correct.

If you are preparing an animation to present as part of a case, it is critical that you can ver-
ify the accuracy of the animation!  Th is is done in Th e Crime Zone and Th e Crash Zone‘s 
animation when you place "reference symbols" based on physical evidence which you have

measured and documented, then draw the animation path exactly through the centers of those symbols.  You 
then create a KEP with the values for speed, yaw, pitch and roll of the object at each reference point. You can see 
the animation movement take you through the reference symbols and verify the object is in the correct position 
at each key location.  Th is validates that the animation is accurate with measured data.  

Animation Viewer Preferences
When the Animation Viewer is displayed (select the Animation icon from the Recon/
Animate toolbox), several options are available by selecting Preferences from the top of 
the window. From Preferences, you can set options for units, display options, number of 
frames per second, frame captions, snapshots, and the path where you want to save any 
movie fi les that you create.

On the Animation Viewer Preferences Toolbox  
there is a handy feature called “Save Frames w/
movie.” If you check this option and then click the 
“Create Movie” button, each frame of the animation 
is saved as a separate .jpg image fi le, along with the 
movie fi le. By default, the movie and the separate 
frames are saved  in your \My Cad Zone\Animation 
folder (under \My Documents) in a folder with the 
same name as the diagram.
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Symbols
3D  34

bullet trajectory  51
drawing on vertical surfaces  49
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taking screenshots  36
viewing in 3D  35

3D builder  35, 50
height and elevation  35
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A                                      
accuracy  41

draw at 1 to 1 scale  11
using snaps  15

Angle Draw  16, 26
animation  55
arrow with text  26
AutoCAD

importing diagrams  30
auto snap  16
Auto Surface  43

B                                      
bitmap drawing vs vector drawing  11
bitmap images  30
bodies

posing  47
Body Poser Toolbox  47
building fl oorplans, drawing  48
bullet trajectories  51

C                                      
CAD diagrams

importing  30
color

fi lling an object  27
object properties  19

combined speeds  42
compatibility  8
coordinate data table  31, 32

connecting points  34
crash reconstructionists  41
crash scenes  37

animating  56
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crash scene symbols  23

Crash Zone  37
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sample diagrams  52

crime scene symbols  23
Crime Zone vs Crash Zone  8
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data collection soft ware

Pocket Zone  32
digital photographs  30
dimensions

drawing  26
setting units  27

display
changing with view commands  17

drawing
3D models  34
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intersections  38
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Easy Streets  39
Easy Surface  43
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editing

commands  20, 23
mouse methods  22

electronic help  9
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fi lling objects

with color  27
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help  9

I                                      
intersections, drawing  38
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J                                      
JPG images  30
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KEP  55
keyboard shortcuts  14
Key Event Point  55
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labels. See  text
laser measurement devices  32
Laser Technology, Inc  32
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Learning Center  9, 12, 18, 20, 23
lettering. See  text
line types  19, 20
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from laser devices  32
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manual  31

measurements, drawing  26
menu

draw  18
text/dimension  26

Message Bar  13
modify objects. See  editing commands
momentum calculator  42
mouse functions  14
move

command for accuracy  23
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movies, animation  55
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pattern, fi lling an object  27
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Pocket Zone  32
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fi tting to the paper  28
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quick pick toolbox  18, 25
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right-click menu  15
roads, drawing  38
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satellite image  30
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drawing to  11
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selecting objects  21
selection methods  21
settings, 3D surfaces  43
shapes. See  symbols
simulation  55
sketching  29
skid analysis  41
snap commands  18

when dimensioning  26
snaps  15
stairs and ramps  49
streets, drawing  38, 39
style

object properties  20
surfaces, 3D  43
symbol manager  40
symbols  23, 37

animation  57
create your own  25
crime scene  46
options for placing  24
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templates, intersection  38
text  25

drawing horizontal  26
placing  25

total stations  32
training materials  9
trajectory, drawing  51
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units

of dimensions  27
update program  8
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vector drawing vs bitmap drawing  11
vehicles  37, 40

sizing  40
vehicle specfi cations database  40
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view commands  17
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width

object properties  19
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